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1 Before You Begin

This chapter contains the following sections:
1.1 Introduction to the System.............cc.vvne.... 1-2
1.2 Running Your First Experiment ................... 1-4
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Chapter 1 Before You Begin

4 1.1 Introduction to the System

General computer
and software tasks

Sample prep tasks

1-2 PerSeptive Biosystems

Basics of the A PerSeptive Biosystems Technical Representative will give
system You a quick introduction to the following:

General computer and software tasks
Sample prep tasks

Acquisition tasks

Processing tasks

Start the computer, start the Voyager software, restart the
computer by pressing Control+Alt+Delete, select Shut
down, then select Shutdown and Restart.

Use Windows NT basic techniques.

Use the mouse, click, click-drag, double-click. Use the
right mouse button.

Use Window NT Explorer to create directories, copy files,
delete files, display file information.

Use the Open File dialog box, double-click to display
lower level directories.

Use Notepad to view text files.
Resize windows.

Change between tasks (press Alt+Tab or use the
Windows Task Manager).

Change between programs.

Open and close programs.

Prepare peptide samples in a-cyano m!étrix.
Prepare peptide samples in sinapinic a'cid matrix.
Load a sample plate.

Clean a sample plate.



Acquisition tasks

Pro@ess/ng lasks

Introduction to the System

Use the Instrument Control Panel.
Use the Sequence Control Panel.
Load, modify, and save instrument settings (.BIC) files.

Use the software or control stick to change the x,y
position of the laser on the sample.

Acquire and save data.
Use the Spectrum window, describe key features.
Use the oscilloscope, describe key features.

Use the LSA1000 LeCroy® digitizer, describe key
features.

Manipulate a trace using all toolbar buttons.

Calibrate a spectrum and apply the calibration to a .BIC
file.
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Before You Begin

g 1.2 Running Your First Experiment

1-4

Purpose

Assumptions

In this guide

The Voyager" Biospectrometry™ Workstation Getting Started
Guide is designed to help you quickly learn how to use the
Voyager Biospectrometry Workstation. It provides
step-by-step procedures for preparing and analyzing:

* A peptide standard containing Adrenocorticotropic
_hormone, clip 7-38 [ACTH (7-38)], Adrenocorticotropic
hormone, clip 18-39 [ACTH (18-39)], and insulin

* A mock peptide sample containing the standard
component ACTH (7-38)

NOTE: This guide assumes that your Voyager Workstation
has been properly installed by a PerSeptive Biosystems
Technical Representative and that the workstation vacuum
pressure is less than 10° Torr on Voyager-DE and
Voyager-DE PRO systems, or less than 5x107 on the
Voyager-DE STR system.

This guide contains brief procedures. For more detailed
procedures and reference information, refer to the Voyager™
Biospectrometry” Workstation User’s Guide.

In the following chapters, you will:

Start up

Prepare samples

Acquire calibration standard spectra
Create a calibration (.CAL) file
Acquire sample spectra

PerSeplive Biosystems



Running Your First Experiment

What you need To perform the experiment in this guide, you need:
* Sample plate with laser-etched sampie positions or wells

¢ o-cyano-4-hydroxycinnamic acid (CHCA) matrix

* Adrenocorticotropic hormone, ciip 7-38
[ACTH (7-38)], 50 pmol/pl in aqueous solution

* Adrenocorticotropic hormone, clip 18-39
[ACTH (18-39)], 50 pmol/ul in aqueous solution

* Bovine insulin, 50 pmol/ul in aqueous solution

NOTE: You can.use the Calibration Mix 2 standard from the
Voyager Mass Standards Kit which contains all of the
components listed above.

See the Voyager Biospectrometry User’s Guide, Appendix B,
Warranty/Service Information, for standard ordering
information.

NOTE: If you do not have a sample plate with laser-etched
sample positions or wells, you can use a polished blank
sample plate. If you use a polished blank sample plate, load
the sample directly under the position number on the plate
to ensure that the laser is centered on the sample when you
move to a sample position.

Voyager™ Biospectrometry™ Workstation Getting Started Guide -5



Chapter 1 Before You Begin

To prepare matrix and sample, you need:

Analytical balance

1.5 mi microcentrifuge tubes

Microcentrifuge (optional) .

Micropipettor and disposable tips

Vortex mixer ;

Deionized water

Acetonitrile

3% Trifluoroacetic acid (TFA) in deionized water
Finely-tapered pipette tips for dispensing matrix and
sample solutions on sample plates

WARNING

CHEMICAL HAZARD. Some of the solvents are hazardous.
Refer to the Material Safety Data Sheet (MSDS) provided
by the chemical manufacturer before handling any of the
substances flisted above.

7-6 PerSeptive Biosystems



2 Starting Up

This chapter contains the following sections:
2.1 Powering Up ............................. 2-2
2.2  Starting the Software

For more information, see the Voyager Biospectrometry Workstation
User’s Guide, Section 2.8, Startup and Shutdown.
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Chapler 2 Starting Up

2.1 Powering Up

The Voyager mass spectrometer is typically powered up at all
times.

To power up the other components of the system:
1. Turn on the following system devices in this order:

* Video monitor

* External digitizer, if your system includes one
* Oscilloscope, if your system includes one

¢ Computer

* Printer

2. If your system includes an oscilloscope, observe the
oscilloscope and wait approximately one minute until it
completes its initialization cycle. When the cycle is
complete, a message stating that the power on self check
passed is displayed, then the oscilloscope screen is
displayed. See Appendix |, Using the Oscilloscope and
Control Stick, for more information.

. If your system includes a LeCroy digitizer, wait
approximately one minute until the digitizer completes
its internal calibration before starting the Instrument
Control Panel.

3. Press the EMIS button on the Vacuum Gauge Panel to
turn on the gauges. Observe the vacuum gauge on the
front panel (Figure 2-1).

PBI00270

Figure 2-1 Vacuum Gauge Panel
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Powering Up

CAUTION

Do not press any other buttons on the panel. Pressing
buttons other than the Chan and EMIS buttons can
recalibrate the pressure scale of the system.

Press Chan to cycle between BA1 and BA2.

Allow the pressure on BA1 and BA2 to reach: ‘

Model

BA1 Pressure
(Torr)

BA2 Pressure
(Torr)

Voyager-DE and
Voyager-DE PRO

Less than 10

Less than 10®

Voyager-DE STR

Less than 5x107

Less than 5 x108

Readings from the vacuum gauges are displayed:

* On the Vacuum Gauge Panel.

* In the System Status control page in the
Instrument Control Panel. See the Voyager
Biospectrometry Workstation User’s Guide,
Section 2.9, Checking System Status, for more
information.

4. Log on to the Voyager Workstation using your User Name
and Password. See your system administrator for your
User Name and Password.

Voyager™ Biospectrometry™ Workstation Getting Started Guide
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Chapter 2  Starting Up

2.2 Star‘ting the Software

Starting To start the Voyager Instrument Control Panel from the
Instrument Windows NT desktop, double-click the Voyager Control icon

Control Pane/ ©°n the deskiop..

Figure 2-2 Instrument Control Panel

Initializing The hardware is automatically initialized when you start the
Instrument Contro! Panel.

2-4 PerSeptive Bjosystems



Starting the Software

Starting the Data To start the Data Explorer software from the Windows NT
Explorer software deskiop, double-click the Data Explorer icon on the desktop.
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Figure 2-3 Data Explorer Window
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3 Preparing Samples

This chapter contains the following sections:

3.1 OVEIVIBW e e 3-2
3.2 Preparing MatrixX ....c.ccooiviiiiiiiiiiiininininnens 3-3
3.3  Preparing Samples ......c.cvevvieereneiiinnrinnanes 3-5
3.4 Mixing Sample and MALIX v veveeeeeeeeseeeneeanns 3-6
3.5 Loading Samples on Sample Plates............. 3-7
3.6 Loading Sample Plates

in the Mass Spectrometer...........ccovvvirnvnnens 3-9

For a detailed description of preparing samples and matrix, see the
Voyager Biospectrometry Workstation User’s Guide, Chapter 3,
Preparing Samples. '

Voyager"” Biospectrometry™ Workstation Getting Started Guide 3-1



Chapter 8 Freparing Samples

3.1 Overview

3-2

Guidelines for
successful
sample
preparation

Matrix stability

Additional
information

To prepare samples, follow these guidelines:

* Prepare fresh matrix as needed. Some matrices require
daily preparation. Other matrices can be stored for up to
one week at room temperature.

¢ Determine the proper dilution of sample.
* Use clean sample plates.

* Properly apply sample and dry to allow good
crystallization.

Some matrices degrade upon exposure to light or humidity.
Some matrices require daily preparation. Other matrices can
be stored for up to one week at room temperature. Follow the
matrix manufacturer’s instructions for storage conditions of
chemicals.

Appendix C, Matrices, in the Voyager Biospectrometry
Workstation User’s Guide, contains additional information on
matrix structure, appearance, and matrix solutions.

PerSeptive Biosystems




Preparing Matrix

3.2 Preparing Matrix

Matrix function In MALDI-TOF MS (matrix-assisted laser desorption ionization
time-of-flight mass spectrometry), the matrix plays a key role
in the ionization process. The well-developed crystals of
matrix material assist in ionizing the biomolecules you are
analyzing.

Selecting matrix As a general guideline, the molecular weight of the
peptide/protein you are analyzing determines the matrix to
use:

* >10,000 Da—Sinapinic acid (3,5-Dimethoxy-4-hydroxy
cinnamic acid)

* < 10,000 Da—o-cyano-4-hydroxycinnamic acid

The compounds you are analyzing have masses less than
10,000 Da, so a-cyano-4-hydroxycinnamic acid is the
appropriate matrix for this application.

Preparing To prepare 10 mg/ml solution of o-cyano-4-hydroxycinnamic
acid matrix: .

1. Label a 1.5 ml microcentrifuge tube with the name of
the matrix, the final concentration, and the date
prepared.

2. Weigh approximately 10 mg of the dry matrix and add it to
the tube.

NOTE: Use a fresh tjp each time you p/pette a different
substance.

Voyager™ Biospectrometry”™ Workstation Getting Started Guide 3-3



Chapter 3 Preparing Samples

3. Add 400 pl deionized water, 100 ul 3% TFA, and
500 ul acetonitrile to the tube.

4. Cap the tube and v‘ortex thoroughly for approximately
one minute. You can shake the tube by hand if you do not
have a vortex mixer.

5. Microcentrifuge the tube for 30 seconds at
2,000 to 5,000 rpm. Alternatively, allow the solution to
settle for about 10 minutes. You may see a precipitate at
the bottom of the tube.

When ydu load matrix, use the supernatant, not the
precipitate.

3-4 PerSeptive Biosystems



Preparing Samples

3.3 Preparing Samples

Preparing Prepare a 50 pmol/ul solution of each of the following
components:
+ ACTH (7-38)
 ACTH (18-39)
» Bovine Insulin

From these solutions you will create:

» Standard solution—Containing all three components
* Mock sample solution—Containing ACTH (18-39)

NOTE: Use preweighed vials of ACTH to ensure accurate
final concentrations. See the Voyager Biospectrometry P
User’s Guide, Appendix B, Warranty/Service Information, =
for standard ordering information.

3

To prepare 50 pmol/pl solutions of each component:

1. Add 1.3 ml deionized water to a 250 ug vial of
ACTH (7-38).

2. Add 4 ml deionized water to a 500 pug vial of
ACTH (18-39). '

=

3. Weigh out 1 mg Bovine Insulin. Add 3.5 ml 0.1%
aqgueous trifluoroacstic acid (TFA).

NOTE: Alternatively, you can prepare the Calibration Mix 2
sample from the Voyager Mass Standards Kit. Follow the
instructions listed in the kit to prepare a 50 pmoljul solution
of Calibration Mix 2.

Storing i you will not use the insulin within four hours, freeze it. If you
will not use the other samples within one day, freeze them.

You can aliquot and freeze unused stock solution for future
use.

Voyager™ Biospectrometry™ Workstation Getting Started Guide 3-5



Chapter 3 Preparing Samples

3.4 Mixing Sample and Matrix

sample solutions

Preparing Mix standard or sample and matrix before loading on the
stfandard and sample plate.

NOTE: You can alternatively mix sample and matrix on the
sample plate. However, when working with a concentrated
sample, or when preparing many samples, premixing
before loading on the sample plate is the preferred method.

To mix sample and matrix:

1. Label two 1.5 ml microcentrifuge tubes with “Standard”

and “Sample” and the date prepared.
\

Standard solution 2. To the “Standard” tube, add 22 pl of matrix solution. Add

3-6

matrix before sample to prevent sample from adhering to
the plastic tube.

3. To the “Standard” tube, add the following (initial ,
concentration 50 pmol/ul for each component, for a final
concentration of 2 pmol/pl of each component):

* 1 ul ACTH (7-38)
* 1 pl ACTH (18-39)
¢ 1 ul Bovine Insulin

NOTE: Alternatively, you can add 1 ul of the prepared
50 pmoll CalMix 2 standard solution.

4. Vortex for 15 seconds.
Sample solution 5. Tothe “Sample” tube, add 24 pl of matrix solution.

6. Tothe “Sample” tube, add 1 pl ACTH (7-38) (initial
concentration 50 pmol/pl, for a final concentration of
2 pmol/ul).

7. Vortex for 15 seconds.

PerSeptive Biosystems



Loading Samples on Sample Plates

3.5 Loading
Samples on Sample PIates

Handling sample To prevent contamination of your analysis:

plates . gy with a clean sample plate. See the Voyager
Bijospectrometry Workstation User’s Guide, Section 3.3,
- Cleaning Sample Plates.

* Handle the sample plate by the edges.

Guidelines for To ensure good crystallization:

. ga.ad * Fill the entire well when spotting the sample plate, if
crystallization possible. Surface tension and sample availability may
determine whether you fill the well completely.

* When using o-cyano-4-hydroxycinnamic acid, do not
touch the surface of the sample well with the pipette tip. It
may cause uneven crystallization.

Guidelines | oad one sample position (or well) with the standard, and one
with the sample.

NOTE: For optimum mass accuracy, place standards in
positions (or wells) adjacent to the samples for which you
are calfbrating, and do not use the outer sample positions
(wells) on the sample plate.

Create a log sheet listing sample position and sample name.
Appendix D, Log Sheets, in the Voyager Biospectrometry
Workstation User's Guide, contains master log sheets that you
can copy and use.

Voyager™ Biospectrometry™ Workstation Getting Started Guide 3-7



Chapter 3 Preparing Samples

Loading samples To load samples:

1. Load 1 i of standard/matrix and 1 ul of sample/matrix
in adjacent sample positions on the plate.

NOTE: Use a fresh pipette tip each time you pick up a
different substance.

2. Allow the sample plate to dry for at least five minutes.

3. Visually examine the sample spots to make sure they are
dry.

4. Place a protective cover over the plate to prevent
contamination until you are ready to load the plate. Do not
allow the cover to touch the surface of the plate.

3-8 PerSeptive Biosystems




Loading Sample Plates in the Mass Spectrometer

3.6 Loading Sample Plates
in the Mass Spectrometer

NOTE: If you load the sample plate into the Voyager
Biospectromelry Workstation before the plate is dry, the
pressure in the sample chamber rises, and a “TC2 pressure
too high” error code may be displayed in the Instrument
Control Panel. Wait a few minutes for the chamber to reach
pressure.

Ejecting the In the Voyager Instrument Control Panel (see Figure 2-2 on
sample holder page 2-4), select Eject from the Sample Plate menu. The
Load/Eject Sample Plate dialog box (Figure 3-1) is displayed.

Figure 3-1 Load/Eject Sample Plate Dialog Box

After you select Eject, the following occurs:

* A Load Status dialog box is displayed during the ejection
sequence which displays hardware status.

voltage is turned off.
* The video monitor displays the sample plate moving.

* The sample holder moves out of the main source
chamber, out of the sample loading chamber, and is
ejected from the instrument.

Voyager" Biospectrometry™ Workstation Getting Started Guide 3-9



Chapter 3 Preparing Samples

NOTE: Do not leave the sample holder in the Eject position
for more than a few seconds. Minimize the time the

instrument is exposed o the atmosphere fo reduce the time
needed to reach high vacuum when you insert a new plate.

Voyager-DE and To load sample plates:

Voyager-DE PRO 1 Eject the sample holder as described in “Ejecting the

sample holder” on page 3-9.

2. Hold the sample plate with the bottom of the numbers
facing toward the analyzer (for standard 100-well plate)
and with the slanted underside of the plate facing to the
left (Figure 3-2).

3. Slide the sample plate into the holder from the right side
until it snaps into place (Figure 3-2). The ball bearings on
the holder snap into the plate.

CAUTION

If the sample plate does not snap into place, it may be
inserted into the holder the wrong way, and it may jam
inside the instrument. Remove the plate, siide it into the
holder with the slanted underside of the plate facing to
the left and foward the back of the instrument, and snap
it into place.

3-10  PerSeptive Biosystems



Loading Sample Plates in the Mass Spectrometer

PB100278

Figure 3-2 Loading the Sample Plate in a Vo yager-DE
or Voyager-DE PRO

WARNING

PHYSICAL INJURY HAZARD. Fingers can get caught
in the sample holder. To avoid injury, do not click Load
to retract the sample holder when your fingers are near
the sample holder.

4. From the Sample Plate menu select Load to retract the
sample plate and insert it into the main source chamber.
The Load/Eject Sample Plate dialog box (Figure 3-3) is
displayed.

is

‘ o
Figure 3-3 Load/Eject Sample Plate Dialog Box
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Chapter 3  Preparing Samples

NOTE: A Select Sample Plate Type dialog box is also
available from the Sample Plate menu in the Instrument
Control Panel. This dialog box allows you to select a
different plate type without ejecting the sample plate.

Sample plate 5. Inthe Plate Type field, select 100 well piate.PLT. For
parameters more information on .PLT files, see the Voyager
Biospectrometry Workstation User’s Guide:

* Section 3.5.2, Editable-Configuration Plate (.PLT)
Types Provided with the System

* Section 3.5.3, Guidelines for Defining
Custom Plate Types

6. Click OK.

The sample plate is aligned as needed. For more
information, see the Voyager Biospectrometry
Workstation User's Guide, “How the system aligns a
plate” on page 2-40.

It takes a minute or two for the sample plate to reach
the correct position. While the sample plate is moving,
the Load/Eject Status dialog box displays messages
about the status of the hardware.

Voyager-DE STR 1o I0ad sample plates:

1. Eject the sample holder as described in “Ejecting the
le holder” on page 3-9.

2. Hold the\sample plate vertically, with the sample surface
facing to t e right, and with the slanted underside of the
plate facing toward the back of the instrument.

3. Slide the sample plate into the holder from-the front until it
snaps into place (Figure 3-4). The ball bearings on the
holder snap into the plate. 7
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Loading Sample Plates in the Mass Spectrometer

CAUTION

If the sample plate does not snap into place, it may be

inserted into the holder the wrong way, and it may jam

inside the instrument. Remove the plate, slide it into the
holder with the slanted underside of the plate facing to

the left and toward the back of the instrument, and snap
it info place.

PB100277

Figure 3-4 Loading the Sample Plate in a
Voyager-DE STR

WARNING

PHYSICAL INJURY HAZARD. Fingers can get caught
in the sample holder. To avoid injury, do not click Load
to retract the sample holder when your fingers are near
the sample holder.

4. From the Sample Plate menu, select Load to retract the
sample plate and insert it into the main source chamber.
The Load/Eject Sample Plate dialog box (Figure 3-5) is
displayed.

Voyager™ Biospectrometry™ Workstation Getting Started Guide — 3-13
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3-14

Sample plate 5.
parameters

PerSeptive Biosystems

Figure 3-5 Load/Eject Sample Plate Dialog Box

NOTE: A Select Sample Plate Type dialog box is also
available from the Sample Plate menu in the instrument
Control Panel. This dialog box allows you to select a
different plate lypes without ejecting the sample plate.

In the Plate Type field, select 100 well plate.PLT. For
more information on .PLT files, see the Voyager
Biospectromelry Workstation User’s Guide:

* Section 3.5.2, Editable-Configuration Plate (.PLT)
Types Provided with the System

* Section 3.5.3, Guidelines for Defining
Custom Plate Types

Click OK.

The sample plate is aligned as needed. For more
information, see the Voyager Biospectrometry
Workstation User’s Guide, “"How the system aligns a
plate” on page 2-40.

It takes a minute or two for the sample plate to reach
the correct position. While the sample plate is moving,
the Load/Eject Status dialog box displays messages
about the status of the hardware.



Chapter
4 Acquiring 4
Calibration
Standard Spectra

This chapter contains the following sections:

4.1 Setting the Instrument Control Panel ............... 4-2
4.2 Acquiring the Standard ............cccoevveinereenenen. 4-9
4.3 Evaluating Data .......ccccoeveeeiicieciiee e 4-19

For a detailed description of acquiring spectra, see the Voyager
Biospectrometry Workstation User’s Guide, Chapter 6, Acquiring
"~ Mass Spectra.
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Chapter 4 Acquiring Calibration Standard Spectra

4.1 Setting the
Instrument Control Panel

To set the Instrument Control Panel for acquisition, you:

* Start the Instrument Control Panel

* Load an instrument settings (.BIC) file
* Set Data Storage parameters

* Select the sample position

4.1.1 Starting the Instrument Control Panel

When you double-click the Instrument Control Panel icon, the
Instrument Control Panel opens (Figure 4-1).

Bk S,

Figure 4-1 Instrument Control Panel
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Setting the Instrument Control Panel

4.1.2 Loading an
Instrument Settings (.BIC) File

Standard instrument settings (.BIC) files that have been
optimized for your system are provided. You can use these
files as a starting point to acquire data and optimize them as
needed.

Loading an From the Instrument Control Panel:

iﬂs””me”t 1. Select Open Instrument Settings from the File menu.
settings (.BIC) The Open dialog box is displayed (Figure 4-2).
file:

\ craE e R selad
argroheiy oo by % vl Bowi i

HEA S

Figure 4-2 Open Dialog Box

Standard instrument setting (.BIC) files provided are
located in the C:\VOYAGER\DATA\FACTORY directory.

2. »Select the following instrument settings (.BIC) file:

* ACTH_Linear.BIC—If you are running in Linear
mode '

* ACTH_Reflector.BIC—If you are running in
Reflector mode

Hint: If the .BIC file you need is not visible, click the |
scrofl bar to view more instrument setting files:

Voyager™ Biospectrometry™ Workstation Getting Started Guide 4-3



Chapter 4 Acquiring Calibration Standard Spectra

.BIC file name

Data Storage
Control page

Active Sample ___I

44

The .BIC file is loaded. The currently loaded .BIC file
name is displayed in the title bar of the Instrument
Control Panel (Figure 4-3).

Loaded

Position

Mass Instrument Settings
Range Control page

Figure 4-3 Instrument Contro/ Panel with ACTH_Linear.BIC File Loaded

If the Instrument Settings control page is not displayed, select
Instrument Settings from the View menu.

Changing instrument settings in a standard .BIC file are optimized for the
instrument mass range shown on the Instrument Settings control page. It
settings s nottypically necessary to change settings.

If you find you need to optimize instrument setting parameters,
see the Voyager Biospectrometry Workstation User’s Guide,
Section 5.4, Optimizing Instrument Settings Parameters.

PerSeptive Biosystems
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Saving a new .BIC i you change any of the optimized instrument settings
file parameters, do not overwrite the .BIC file loaded on your

system. Select Save As from the File menu and type in a new
file name.

4.1.3 Setting Data Storage Parameters

To set Data Storage parameters:

1. Ifthe Data Storage control page is not displayed, select
Data Storage from the View menu.

The Data Storage control page is displayed
(Figure 4-4).

Figure 4-4 Data Storage Control Page

2. Click Lz to selecta directory in which all data files will
be stored.

Hint: To keep instrument seltings and data organized,
create a Gelling Started directory. On the Windows
deskiop, double-click the My Computer icon.
Double-click the C: drive, then double-click the Voyager
directory. From the File menu, select New Folder, and
type Geltting Started.
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3.
4.

Type the file name CalMix2.

Select Autosequence Filenames if you want the
software to determine the next available sequential file
name. :

In the Sample Description/Comment text box, enter text
that will be saved with the data file. This step is optional.

For more information on data storage, see the Voyager
Biospectrometry Workstation User's Guide, “Setting
Data Storage parameters” on page 6-14.

4.1.4 Selecting Sample Position

4-6

To select sample position, do the following:

1.

PerSeptive Biosystems

If the Manual Laser/Sample Positioning control page is
not displayed, select Manual Laser/Sample Positioning
from the View menu.

The Manual Laser/Sample Positioning control page is
displayed (Figure 4-5) and reflects the .PLT file you
selected when you loaded the sample plate.

Select the standard position to analyze by doing any of
the following in the Active Position box:

* Type a position number
* Select a position number from the drop-down list
* Single-click on a sample position

You can hear the sample transport moving inside the
mass spectrometer, and can see the sample plate
moving on the video monitor. It takes a few seconds for
the sample piate to move to the proper position.

NOTE: You can also use the Control Stick to select the
Active Position. See Figure 4-7 on page 4-10.




— Setting the Instrument Control Panel

Laser .
intensity Laser
) controls
Active PLT
position file loaded

Figure 4-5 Manual Laser/Sample Positioning Control
Page (Plate View) with a 100 Well Plate.PLT File
Loaded

3. From the Sample Plate menu, select Sample View to
display an expanded view of the selected sample position
(Figure 4-6).
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4-8

Click-drag
scroll bars
to move
sample plate
under laser

Figure 4-6 Manual Laser/Sample Positioning Contro/

4.

PerSeptive Biosystems

Page (Sample View)

You can fine-tune sample plate position under the laser by
click-dragging the scroll bars or moving the control stick.

For more information, see the Voyager Biospectrometry
Workstation User’s Guide, Section 4.5.2, Adjusting
Laser Intensity and Selecting Sample Position.
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4.2 Acquiring the Standard

In this section, you will:

Adjust laser intensity

Start acquisition

Observe the signal

Check for peaks of interest

4.2.1 Adjusting Laser Intensity

Determining the Optimized laser settings are stored along with the optimized
selting for your instrument settings in the .BIC files provided with your system.

Ssystem When you start the Instrument Control Panel, the laser
intensity is set to 1,800.

When you load a .BIC file, the last laser setting saved in the
.BIC file is loaded.

Adjusting laser To adjust laser intensity, click-drag the slider control or fine
intensity and coarse buttons on the Manual Laser/Sample Positioning
control page (see Figure 4-5 on page 4-7). For more
information, see the Voyager Biospectrometry Workstation
User’s Guide, Section 4.5.2, Adjusting Laser Intensity and
Selecting Sample Position.

Hint: You can also set laser intensity by pressing
Ctrl+PgUp and Ctrl+PgDn on the keyboard. Pressing
these keys adjusts intensily in the same increments as the
fine laser control buttons.

Laser settings in this example, we will recommend certain laser intensities.
used in this guide However, the recommended laser intensities may not be
appropriate for your system. Appropriate laser intensities vary
from system to system. Use the appropriate setting for your
system. For more information on laser settings, see the
Voyager Biospectrometry Workstation User’s Guide,
Section 5.4.2, Determining the Laser Setting.
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4.2.2 Starting Acquisition

High voltage
warm-up for
improved mass
accuracy

Starting
acquisition

data acquisition

For maximum mass accuracy, allow the high voltage power
supplies to warm up for a short period of time before
acquisition. Allowing the high voltage power supplies to warm
up before acquisition reduces variability in accelerating
voltages, and yields more reproducible ion flight times.

To turn on the high voltage power supplies, click in the

toolbar.

NOTE: The high voltage power supplies are automatically
turned off after 60 minutes if the mass spectrometer is not
used. To change the Idle Time, see the Voyager
Biospectrometry Workstation User’s Guide, “High voltage
configuration” on page 2-33.

Start acquiring, which starts the laser, by doing one of the
following: ‘

* Click
* Select Start Acquisition from the Acquisition menu.

* Press the left button (the button farthest from the cable)
on the base- of the control stick (Figure 4-7).

{1 in the toolbar.

Move stick

up and down,
left and right

to adjust sample
position under
laser beam

Start/stop

Figure 4-7 Conftrol Stick
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4.2.3 Observing the Signal

During acquisition, a Live trace is displayed and updated in the
Spectrum window.

NOTE: On systems with Tektronix oscilloscopes, no Live
trace is displayed. A Current trace is displayed after
acquisition is complete.

When acquisition is complete, you should see a Current trace
in the Spectrum window, similar to the figure shown in
Figure 4-8, that includes the following peaks:

* Angiotensin—1296 Da

* ACTH (18-39)—2,466.71 Da
* ACTH (7-38)—3,660.17 Da
* Insulin—5734.54 Da

Status bar
shows
acquisition
status

Figure 4-8 Current Trace in Spectrum Window
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If you do not see I you do not see any signal during acquisition, or if signal
signal intensity is low, move the sample plate under the laser until
you see a signal by doing one of the following:

* Click-drag scroll bars in the Sample View of Manual
Laser/Sample Positioning control page (see Figure 4-6
on page 4-8)

* Move the control stick knob to the left and right, or up and
down

When you find an acceptable signal, stop acquisition as
described below, then restart acquisition. It is good practice to
acquire actual data from one location in the same sample
position.

Stopping Acquisition continues until the number of shots specified in
acquisition Shots/Spectrum in instrument settings are collected.
Alternatively, you can stop acquisition when you observe an
acceptable signal by:

* (Clicking in the toolbar.

* Selecting Stop Acquisition from the Acquisition menu.

* Pressing the left button (the button farthest from the
cable) on the base of the control stick (see Figure 4-7 on
page 4-10).

CAUTION

Check fo see if acquisition has already stopped
automatically before manually stopping. If acquisition-has
stopped, the Spectrum window stops updating, and the
Instrument Control Panel status bar displays
“Acquisition-OFF” (it displays “Acquisition-ON” during
acquisition). See Figure 4-8 on page 4-11.

If acquisition has stopped and you restart acquisition with
the software or control stick, you will begin a new
acquisition and overwrite the Current spectrum.

The signél is acceptable when the peaks stabilize, and stop
expanding upward.
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4.2.4 Checking for Peaks of Interest

When acquisition is complete, check for peaks of interest:

¢ Zoom in and check peak shape

* Eliminating unwanted peaks

* Check masses

* Reacquire with lower laser intensity
* Save the data file

. Zooming to check To zoom in on the trace to examine peak shape:

peak shape 1  position the cursor above and to the left of the first
peak of interest.

2. Hold down the left mouse button and click-drag a box
around the area to zoom. Make sure to click-drag within
the Spectrum window (Figure 4-9).

Click-drag
a box around
these peaks

’

Figure 4-9 Zooming on Peaks
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The selected area is magnified.

You can also use the following zoom toolbar buttons:

* Click to Zoom in.

* Click 0 Zoom out.

* Click § for Full Unzoom.

3. Examine the peaks and the right axis in the Current
Spectrum trace to determine if signal is saturated
(Figure 4-10).

Cosrant Gpes 10 (T80 < HNGHR. B5' < W97, BSSTHL Check for
™ s G_“; ' signal
1

saturation

% btonaily
B

R

Figure 4-10 Evaluating the Spectrum—-Saturated Signal and Broad Peaks
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NOTE: By default, the right axis is set lo Display
Relative mode, which means it updates to reflect the
intensity of the most intense peak in the currently
displayed region of the trace. You can set the right axis
fo display an absolute value if desired. For more
information, see Voyager Biospectromelry Workstation
User's Guide, “Accessing graphic options” on

page 4-22,

Note the following about the example shown in
Figure 4-10: N

* Intensity of the large peak is near 66,000,
indicating that the peak may be saturated.

* Peaks are broad. You can determine if peaks are
broad by checking resolution as described on
page 4-20.

These conditions indicate that the laser power is too
high. Before collecting another spectrum at a lower
laser setting, eliminate noise peaks and check masses
to make sure the spectrum contains the peaks of
interest.

Eliminating To eliminate unwanted peaks:

unwanted peaks 1|  From the Tools menu, select Peak Detection.

2. Inthe Peak Detection dialog box, set the Minimum
Intensity to 20 and click OK.

Peaks with an intensity below 20 counts are no longer
labeled (Figure 4-11).
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"

% iiressit

Pttt S 596 U0, ERRBHRNE, 99 200,50, RO
i o St

F) ] ]
Mo st

Checking masses

Reacquiring with
lower laser
intensity

Figure 4-11 Spectrum with Noise Peaks Eliminated

With the noise peaks eliminated, you can more easily evaluate
remaining masses. Masses are within the expected range for
the standard, so you can reacquire using the same instrument
settings, but a lower laser intensity.

To reacquire with lower laser intensity:

1. Adjust laser intensity between 1,100 and 1,200 using
the slider control on the Manual Laser Intensity/Sample
Positioning Control page (see Figure 4-5 on page 4-7).

2. Start acquisition. See “Starting acquisition” on page 4-10
for information.

3. Observe the signal.
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You should see a trace similar to the trace in

Figure 4-12. At a lower laser intensity, signal is no
longer saturated (examine the right axis) and peaks are
narrow and well-resolved.

vt Span 329 [HC - JERMEEE, B0~ FRLB, 53685
T A 2

R

% lnnwsiy
g

T P 2
S Yoyt

E2

Figure 4-12 Spectrum Acquired at Lower Laser Intensity-—Signal Not Saturated
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Saving the data To save the data file:
file 1. select (click on) the Current trace.

2. Click in the toolbar to or select Save Spectrum from
the Acquisition menu. The data is saved using the file
name specified in the Data Storage control page.
Information about the data file is displayed in the Data
Storage tab in the Output window at the bottom of the
Instrument Control Panel (Figure 4-13).

SpRchren s wathen U thig file CAVispapeiQaeiting Sentedioein

Figure 4-13 Data Storage Tab in Output Window

N
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4.3 Evaluating Data

To evaluate data:

* Examine the spectrum
* Check resolution
* (Calculate signal-to-noise

4.3.1 Examining the Spectrum

Examine the spectrum to check that:

* Peaks of interest are present
* ' Peaks are sharp
* Peaks are well-separated

Figure 4-14 show an acceptable signal in the Spectrum

window.
Lkt Bosmpwbonad Spson 8F {H000 » B5000R0. 88 = P00, OuRg
18 P 3 N
22
-
Fi
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i
-
an
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T (15 S e 4
Waw derei

Figure 4-14 Acceptable Signal in Spectrum Window
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4.3.2 Checking Resolution

You can calculate mass resolution for up to four peaks in the
Current trace. The resolution values are dlsplayed in the trace
next to the mass value for the peak.

Calculating To calculate mass resolution:

resolution Select the Current spectrum of interest.

——h

2. From the Tools menu, select Resolution Calculator.

3. Inthe Resolution Calculator dialog box (Figure 4-15), set
the percentage of Peak Height at which to calculate
resolution. The default is 50%, which calculates the
resolution at the full width/half maximum of the peak
(FWHM).

4. Set Minimum Peak Intensity. Signals below this intensity
are not included in the calculation.

Figure 4-15 Resolution Calculator

5. Type in up to four Mass/Charge values for which to
calculate resolution, or right-click-drag over peaks in a
Current spectrum trace to select values.

6. For each Mass/Charge, enter the window for calculation
(= AMU).
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NOTE: To /abel isotopes, set the + AMU value low
enough to prevent the calculation windows for each
isotope peak from overlapping. If the calculation
windows overlap, only the highest peak is labeled.

7. Click OK.

The peaks are labeled with (RXXXX) next to the peak
mass, where XXXX is the resolution (Figure 4-16).

Resolution CEtPn] S 46 (O = TRGRR B9 - PHEY, S350
result - —( e wpte v T
i
# 4
Y

m
B

E

fx

#

Figure 4-16 Resolution Calculator Results—Example of Good Resolution

Voyager™ Biospectrometry™ Workstation Getting Started Guide — 4-21




Chapter 4  Acquiring Calibration Standard Spectra

Determining if Compare the resolution you obtain to the following table

resolution is

acceptable

(Table 4-1).

Table 4-1 Resolution Rating Scale

Compounds 2,000

Compounds Compounds 5,000 Compounds
< 2,000 Da to 5,000 Da to 25,000 Da > 25,000 Da
Resolution| Rating - |Resolution| Rating Resolution Flaﬂng Resolution] Rating
500 Not 250 Not 500 Not 50 Acceptable
acceptable acceptable acceptable

1,500 Acceptable | 400 Acceptable | 700 Acceptable | 100 Good
2,000 Good 500 Good 900 Good >200 Very good
2,500 Very good | >600 Very good | 1,000 Very good _— —_—

4.3.3 Calculating Signal-To-Noise

Calculating To calculate a signal-to-RMS noise ratio:
signal-to-RMS

. : Select the Current spectrum of interest.
noise ratio

From the Tools menu, select Signal-to-Noise Calculator.

3. Inthe Signal to Noise Calculator dialog box (Figure 4-17),
set the Baseline Region by doing one of the following:

* Type in From and To values

* In the Spectrum window, right-click-drag over the
baseline area you want to use in calculating
signal-to-noise ratio.

4. Type in up to four Mass/Charge values for which to
calculate signal-to-noise ratio, or right-click-drag over
peaks in a Current spectrum trace to select values.
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Figure 4-17 Signal to Noise Calculator

5. For each Mass/Charge, enter the window for calculation
(= AMU).

NOTE: To Jabel peaks, set the = AMU value low enough
to prevent the calculation windows for each peak from
overlapping. If the calculation windows overlap, only
the first peak is labeled.

6. Click OK.

The peaks are labeled with (SXXX) next to the peak
mass, where XXX is the signal-to-noise ratio.
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F P RPN B e R R, Y

Signal-
to-noise -
result

Bt

i

B

Flaak finlny

Figure 4-18 Example of Good Signal-To-Noise

After determining that the data is acceptable for the standard,
create a calibration file as described in the next chapter that
you will add to instrument settings and use to acquire the
sample.
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Chapter
5

5 Creating a
Calibration
(.CAL) File

This chapfter contains the following sections:

5.1 OVEIVIEW ....ooiiiiiiirr et 5-2
5.2  Opening the Data File in Data Explorer............. 5-3
5.3  Processing Before Calibrating..........cccceveeenneen.. 5-4
5.4  Calibrating .....cccccceeveeievivineie e e S 5-6
5.5 Exporting the Calibration (.CAL) File....cccoeuene 5-9
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5.1 Overview

Before you analyze samples (described in Chapter 6,
Acquiring Sample Spectra) generate a calibration (.CAL) file
from the standard you acquired in the previous chapter. Before
acquiring the sample, you will add this calibration (.CAL) file to
your instrument settings.

The section describes the procedures necessary for you to
calibrate data. In this chapter, you will:

* Open the data file in the Data Explorer software

* Perform procedures before calibrating to enhance mass
accuracy

¢ (Calibrate

* Export the calibration (.CAL) file
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5.2 Opening the Data File in the
Data Explorer Software

Last acquired file When acquisition is complete, the most recently acquired data
automatically file is automatically displayed in the Data Explorer window. If
opens Youare continuing from the previous chapter, skip to
. Section 5.3, Processing Before Calibrating.

Manually opening i you are calibrating using-a previously acquired data file, do
the following in the Data Explorer window:

1. i the Data Exp;lorer window is not visible, double-click
on the icon in the Windows task bar at the bottom of the
desktop.

2. From the File menu in the Data Explorer window, select
Open. )

3. Navigate to the Getting Started directory and select
CALMIX2.DAT.

The CALMIX2.DAT file is displayed in the Data Explorer
window (Figure 5-1).

B 40 - 1958, ST
SEALGE

Mg

Figure 5-1 CALMIX2.DAT in Data Explorer
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5.3 Processing Before Calibrating

To optimize.mass accuracy, do the following before calibrating:

* Baseline correct
* Smooth
* Deisotope

To process: .
1. Inthe Data lorer window, click on the spectrum

trace.

Baseline 2. From the Process menu, select Baseline Correction.

correcting The spectrum is baseline corrected. For more
information, see the Dala Explorer Software User’s
Guide, Section 5.8.2, Using Baseline Correction.

Smoothing 3. From the Process menu, select Noise Filter/Smooth.

The Noise Filter/Smooth dialog box (Figure 5-2) is
displayed.

i

Figure 5-2 Noise Filter/Smooth Dialog Box

4. Select Default for the smoothing method and click OK.

The spectrum is smoothed and displayed with an RSM
trace label. For more information, see the Data Explorer
Software User's Guide, Section 5.7, Noise
Filtering/Smoothing.
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Processing Before Calibrating

Deisotoping 5. Make sure peaks are isotope-resolved (typical if you are
analyzing Reflector mode data).

If peaks are not isotope-resolved, skip to Section 5.4,
Calibrating.

If peaks are isotope-resoived, select Peak Deisotoping
from the Peaks menu.

The Deisotoping dialog box (Figure 5-3) is displayed.

Figure 5-3 Deisotoping Dialog Box

6. For this example spectrum, sp‘ecify H for Adduct and
C6H5NO for Generic Formula.

7. Click OK.

The spectrum is reduced to a monoisotopic centroided
plot of the monoisotopic masses. For information, see the
Data Explorer Software User's Guide, Section 3.4,
Deisotoping a Spectrum.
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5.4 Calibrating

In this example, you will calibrate using the ACTH(18-39)
peak at 2,466.71 Da, and the Insulin peak at 5,734.50 Da.

To calibrate the deisotoped spectrum:

1. From the Peaks menu, select Peak Label, and select
the Mass Label Type (pedk apex or peak centroid) to
use for calibration. Click OK.

2. From the Process menu, select Mass Calibration and
then select Manual Calibration.

The Manual Mass Calibration dialog box is displayed
(Figure 5-4).

Figure 5-4 Manual Mass Calibration Dialog Box
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Calibrating

3. Click | and select the VOYAGER.REF calibration

reference file.

4. Enter Reference Matching and Calibration Criteria.

NOTE: For descriptions of calibration parameters, see
the Data Explorer Software User’s Guide, Section 5.3,
Manual Calibration.

Matching peaks 5. Click Match Peaks and Solve.

The software compares observed masses in the
spectrum to reference masses in the selected reference
file, lists the matches in the Peak Matched list,
calibrates the spectrum, and displays the calibration
statistics in the Output window.

NOTE: If you set Mass Tolerance too low, no peaks will
maich.

You can also add peaks to the Peaks Matched list by
right-click-dragging on a peak in the spectrum, then

- selecting the mass from the Reference Peak Information
dialog box displayed. Click Solve and Plot after manually
adding masses.

The spectrum is calibrated and displayed with an MC
trace label. The calibration statistics are displayed in
the Output window.
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Applying 6. It the calibration statistics are acceptable, click Apply
Calibration to save the calibration to the data file.

After calibration Figure 5-5 shows the deisotoped spectrum after calibration.
Note that the trace labels reflect the processing that has been
performed on the data. For more information, see the Data
Explorer Software User'’s Guide, Section 2.4.1 0, Viewing
Trace Labels.
Trace labels ,
N :
Ky HTAEIE 2 FLM 0080 > D BEEID « 1501, BN
BAEY :
128 K O a2 2
wrz i HETA " e asall
W we Fevstut

Figure 5-5 Deisotoped Spectrum After Calibration

For more information on creating an external .CAL file, see the

Data Explorer Software User’s Guide, Section 5.3, Manual
Calibration.
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5.5 Exporting the
Calibration (.CAL) File

To export the calibration for use during acquisition:

1. From the File menu, select Export, then select
Calibration. This function exports the last applied
calibration constants to a stand-alone .CAL file.

2. Inthe Save As dialog box, type ACTH_Linear_Cal or
ACTH_Reflector_Cal as the name for the exported
.CAL file.

3. Click Save.
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6 Acquiring
Sample Spectra

This chapter contains the following sections:

6.1  Modifying Instrument Settings for
Sample AcqUISItion ......c.cccoccviceiiieececceer e, 6-2

6.2  Acquiring Sample .....cccccocevriieenr e e, 6-3
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6.1 Modifying Instrument Settings
for Sample Acquisition

To modify instrument settings for sample acquisition, specify
the calibration file you created in the previous chapter:

1. Inthe Instrument Settings control page, click Manual.

2. In the calibration section, select External File and the
ACTH_Linear_Cal or ACTH_Reflector_Cal file that you
created in Chapter 5, Creating a Calibration (.CAL) File.

Saving .BIC file 3. Save this new Instrument Settings (.BIC) file as
ACTH_Linear_Cal.BIC or ACTH_Reflector_Cal.BIC.

~
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6.2 Acquiring Sample

Selting Data . Specify Data Storage location as described in Section 4.1.3,
Storage Setting Data Storage Parameters. :

Selecting sample Select the sample position for the mock standard as described
position in Section 4.1.4, Selecting Sample Position.

Starting To start acquiring, select Start Acquisition from the
acquisition Acquisition menu, or click

Acquisition starts and continues until the number of
Shots/Spectrum specified in Spectrum Acquisition on the
Instrument Settings control page is collected, or until you
select Stop Acquisition from the Acquisition menu or click
1 again.

Adjusting laser It necessary, increase or decrease the laser intensity as

intensity described in Section 4.2.1, Adjusting Laser Intensity, until you
observe acceptable signal intensity.

During During acquisition:

acquisition . The\ive trace in the Spectrum window updates to display
. * the spectrum that results from each laser shot.

NOTE: If your system includes an oscilloscope, the
Current Spectrum does not display a trace untif
acquisition is complete. The spectra that result from
each laser shot are displayed on the oscilloscope
screen.

* The system averages all spectra acquired since you
started acquisition.
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When acquisition is complete, the software displays the data
in a Current trace in the Spectrum window (see Figure 6-1).

Coieanl Hper 2 B0 - NN, BF - PRGAT. SV
i L e it

% Internity
B

Faws i)

Figure 6-1 Sample Specitrum

Evaluating data Evaluate the data as described in Section 4.3, Evaluating
\ Data.

You can also examine the data in the Data Explorer software.
See the Data Explorer Software User’s Guide for information.
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axis 4-15 |
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during 4-22
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stopping acquisition 4-12
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High voltage
standby time period 4-10
warmup before calibration 4-10
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/

Initializing hardware 2-4
Instrument Controi Panel
loading sample plates 3-9
parts of 4-4
starting 2-4
Instrument settings file (BIC)
in Control Pane! 4-2
loading 4-3
location 4-3
name displayed 4-4
saving 4-5
Insulin )
mass 4-11
ordering 1-5
lon source warmup 4-10

Isotopes, resolution labels not
displayed for all peaks 4-21

L

Laser intensity
adjusting 4-9
too high 4-15

Linear mode 4-3

Log sheet 3-7

M

Mass accuracy
and location of standard 3-7
improving 3-7, 4-10, 5-4
troubleshooting 3-7

Mass spectrometer, loading sample

plates 3-9

Matrix
mixing with sample 3-6
preparing 3-3
storage conditions 3-2




MC in spectrum he
Monoisotopic peak

Index

ader 5-7 R

deisotoping a spectrum 5-5 Reference masses, calibration
reducing trace to 5-5 selecting 5-7

N

Requirements for experiment 1-5

Resolution
rating scale for MW ranges 4-22

Noise Filter/Smooth 5-4 Resolution, mass
Noise, eliminating 4-15 calculating during acquisition 4-20

o

Oscilloscope initialization 2-2
Output window, Data Storage tab 4-18

P

Password 2-3

/ calculating for live data 4-20
labels not displiayed 4-21
rating scale for MW ranges 4-22
results for live data 4-21

Results '
resolution, mass 4-21
signal-to-noise ratio 4-23

Right axis, changing scale 4-15

RSM trace label 5-4

Peak detection, eliminating unwanted
peaks 4-15 S
Peak labels
. Sample
resolution 4-21 acquiring 6-1

signal-to-noise
Peak shape
checking 4-13

description of acceptable 4-19

Peaks

4-23 guidelines for good

crystallization 3-7
guidelines for preparation 3-2
loading on plates 3-7

log sheet 3-7

checking for 4-13 mixing with matrix 3-6

eliminating noise 4-15 preparing 3-6 .

zooming 4-13 selecting position to analyze 4-6
Pipette tips, recommended 1-6 volume to load on plate 3-7
Plate View 4-7 Sample plate
PLT files, selecting 3-11, 3-13 consequence of loading wet
Powerup sequence 2-2 plate 3-9

Pressure, vacuum

drying time 3-8

handling 3-7

loading in mass spectrometer 3-9
loading sample 3-7

moving position under laser 4-10
proper orientation 3-10, 3-12

1-4, 2-3
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Sample plate (continued)
selecting type 3-11, 3-13
spotting sample and standard

location 3-7
using outer rows 3-7
volume of sample to load 3-7

Sample View 4-8

Saving a data file 4-18

Signal
if you do not see 4-12
observing 4-11

Signal, saturated
checking 4-15
number of counts 4-15

Signal-to-noise ratio
acceptable 4-19
calculating during acquisition 4-22
calculating for live data 4-22
labels not displayed for all

. peaks 4-23
results 4-23 .

Sinapinic acid, when to use 3-3

Smoothing 5-4

Spectra
acceptable 4-19
starting acquisition 4-10, 4-12
stopping acquisition 4-12

Spectrum window
right axis, displaying Absolute

counts 4-15

Spotting sample 3-7

Standard
acquiring 4-9
spotting next to sample 3-7

Standby mode, high voltage power

supplies 4-10

Startup sequence 2-2

Stopping acquisition 4-12
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U

User Name 2-3 _

V

Vacuum gauge panel 2-2
Vacuum pressure 1-4
Voyager basics 1-2
VOYAGER.REF 5-7

w

Warnings, safety
sample holder retraction 3-11, 3-13

Z

Zooming in the Spectrum window 4-13



